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Introduction
Welcome to the Command Ops (CO) ScenMaker. The ScenMaker is used to create and modify CO 
scenarios. You can also use it to access data about unit and equipment establishments (Estabs).

It is a standard Microsoft® Windows® application with a menu bar at the top. This includes the standard 
File menu that allows you to open, close, create new scenarios, save and save as existing scenarios.

Please note that this manual uses screenshots from the original Airborne Assault:Conquest of the 
Aegean ScenMaker. While the name has changed and in some places there are a few cosmetic changes, 
the details depicted remain the same. Where there has been a material change, then new graphics have 
been substituted.

What’s in this Manual
This manual is organised in two parts – the Basics and the Guide. The Basics provide an overview 
of the user interface. The Guide walks you through the steps for creating and modifying scenarios. It 
starts with creating a new scenario completely from scratch; if you want to start by editing an existing 
scenario, just jump in at that section. If you want to know how to do a specific thing, look up the table 
of contents. Annex B provides a sequence of steps for designing a scenario and Annex C provides a 
Scenario Checklist.

Known Issues
There is one known issue for the ScenMaker. The application does not support large text scaling; if you 
find that text and button labels are not being correctly displayed, you will need to adjust your desktop 
appearance to use the standard 96 dpi setting.
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What’s an Estab?
In playing the game, you will have noticed that units have a maximum allocation of personnel and 
equipment, and that all units of the same type (for example, the mortar platoons of 1941 German 
Infantry Regiments) have the same allocation. This theoretical manning and equipment issue is referred 
to in this manual as an Estab. What’s in the estab for a unit?

	Personnel numbers at full strength

	Equipment types and quantities at full strength

	Ammunition, food and fuel quantity when fully supplied

	Capabilities such as engineer capacity

	Movement speeds and mobility type (motorised or non-motorised)

	Combat class (for example, Line, Line Support, or HQ),

	Unit size (for example, company or division), and

	The picture and military symbols displayed on the unit icon

The items of equipment such as vehicles and weapons held by a unit estab each have their own estabs, 
which can include information like:

	Basic descriptive information such as length, weight, and calibre for weapons

	Weapon rates of fire, shell bursting radius, and accuracy and armour penetration at various 
ranges

	Vehicle personnel and cargo capacity, movement speed and fuel consumption

	Armour thicknesses for Front, Sides, Top and Rear for armoured vehicles

	The type of equipment (such as Gun, Small Arm, Mortar, Tank or Truck)

Many equipment estabs also include a picture of the item and a brief description. You cannot edit the 
estabs; however, you can view the information using the ScenMaker - see Estabs Tab.
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The Basics
This section gets you started and provides an overview of the user interface.

Getting Started
To launch the ScenMaker application:

	 Select the ScenMaker program from the Start > Programs > Command Ops 
menu

The ScenMaker will open, with no scenario loaded and showing only the standard Windows menus.

Open a Scenario

To open an existing scenario:

	 Select File > Open...

	 Double-click the desired scenario or

	 Select the desired scenario and click Open
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Note that the Open Scenario dialog 
will open within the last visited 
directory. This may often be the Saved 
Game directory if you had just played 
a game. So you will need to navigate 
back up to the game directory where 
you will find the Scenarios directory.

Save a Scenario

To save an existing scenario:

	 Select File > Save

The scenario file will be saved to disk in the background.

To save an existing scenario under a different name:

	  Select File > Save As...

	 Enter a name

	 Click Save
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Avoid overwriting the orignal scenarios provided. These should be “read-only” but this can be changed 
in file properties. Best to Save As after opening one of these. 

Close a Scenario

To close the currently opened scenario:

	 Select File > Close

The User Interface – A Quick Tour
With a scenario open, the main screen displays a Battlemap, a sidebar and a Menu bar. 

The following is a quick overview of the main user interface items. If you want to start editing or 
creating a new scenario straight away then go to Create a New Scenario.
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Battlemap 

The Battlemap functions in much the same away as in the Game. You can scroll 
it using the same right mouse button and drag method and also by dragging the 
viewable area rectangle within the Stratmap. However, there is no autoscrolling at 
the map edge as there is in the Game. You can zoom in and out using the mouse 
scroll wheel or using the Zoomer control on the Sidebar. 

To view the terrain info at a particular location:

	 Right click on the desired location

The terrain info popup appears just as in the Game.

To display the 1km map grid:

	 Select 1km Grid from the View menu or hit the G 

key 

Unit Icons

Unit icons are overlaid on the Battlemap. Their Info 
Boxes are manipulated using the same F-Keys as in the 
Game. Note that F1, which displays Task Info is blank as 
tasks are not assigned until within the Game. 

To select a unit:

	 Click on its icon

Note the white open ended box which denotes the unit’s footprint or the 
area it occupies.

	You cannot use the cursor keys to navigate the chain of 
command in the ScenMaker

To open its Unit Data window: 

	 Double-click on the unit’s icon or 

	 Select the unit and hit Enter

	You can have multiple Unit Data windows open at 
once.
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To place a unit on the map:

	 Drag the unit from the Units tab in the Sidebar to the desired location

	If the location is impassable the unit icon will snap to the closest passable location

To move a unit icon:

	 Drag it to the desired location

	 Drag it from the Force List to the desired location

	If the location is impassable the unit icon will snap to the closest passable location

To remove a unit from the map:

	 Select on the unit from the Battlemap and press the Delete  key, or

	 Open the Unit Data window click on the Remove From Map button and hit OK to 
confirm.

	Selecting a unit in the Force List and pressing the Delete  key will delete the unit 
from the scenario entirely!

	Always make sure you click on the unit on the Battlemap before pressing the Delete 

  key

The facilities for customising unit display that are available in the game can 
also be used in the ScenMaker. 

To change the style of unit type symbol:

	 Select View>Unit Icons>Military Symbols

When ticked this will display military symbols. When un-ticked it will 
display picture symbols. 

To change the Unit Info Box filter:

	 Select the desired filter from the Select View->UnitIcons menu or

	 Hit the appropriate F-Key
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To filter the units by type:

	 Hit the same number keys as used in the Game

To toggle between large and small unit icons:

	Hit the tilde key.

Objective Icons

Also overlaid on the map are objective 
icons for each side. The latter are sometimes 
referred to as “side tasks”. These in effect 
become the side’s objectives in the Game  
see Set Objectives.

To select an objective:

	 Click on its icon

Note the yellow circle drawn around the 
objective denoting its perimeter or the area 
that must be secured or defended or in which 
units must be exited.

To open its Unit Data window: 

	 Double-click on the objective’s icon 

	You can only have one Objective Data window open at once. 
However, you can view the data for all your objectives in the 
Victory Conditions Window.

Note that if the Objective Data window is already open, then double-clicking another objective 
refreshes the window with the new objective’s data.

To move an objective icon:

	 Drag it to the desired location

	 If the location is impassable the unit icon will snap to the closest passable location
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Crossing Icons

Crossing icons appear on the map wherever a crossing line was drawn 
on the map – see MapMaker Manual. While you cannot move or 
delete them, you can change their type and prime and unprimed them in 
the ScenMaker – see Set Crossings.

There are six levels, namely rail bridge, heavy meduim and light road 
bridge, ferry or ford and potential crossing. 

To select a crossing icon:

	 Click on its icon

To prime and/or un-prime a crossing:

	 Double-click on its icon

This will toggle the priming state – ie an unprimed 
crossing will become primed and vice versa. 
The background colour of an unselected primed 
crossing is pink, while it is white for an unprimed 
crossing.

To change the type or level of crossing:

	 Hold the Shift key down and double-click the icon

	 Repeat until the desired level is displayed

You cannot change a road crossing to a rail bridge. However you can 
change a rail crossing to a road bridge.

	Changing the level automatically un-primes the crossing.
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SEP Icons

Each side may have one or more Supply Entry Points ( SEPs ) marking the location at which new 
supplies may arrive during the game. 

To select an SEP:

	 Click on its icon

To open its SEP Data window: 

	 Double-click on the objective’s icon 

	You can have multiple SEP Data windows open at once.

To move an SEP icon:

	 Drag it to the desired location

	If the location is impassable the unit icon will snap to the closest passable location

Sidebar

The Sidebar is similar 
to that in the Game. The 
Stratmap and Zoomer 
work the same. The 
Objective tools work 
in a similar fashion to 
the Order tools in the 
Game. Use these to 
create your objectives. 
However the types of 
objectives are limited 
to Defend, Secure, 
Secure Crossing, Deny 
Crossing and Exit – see 
Set Objectives. There 
is also an SEP tool for 
creating SEPs and a 
Cancel button which 
is used to return the 
mouse pointer to the 
arrow selection cursor.
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The Intel Display button is used to hide actual units and display intel reports. Below that is the 
Enemy Intelligence Level popup. This is used to specify the accuracy of an intelligence report. For 
more details see  Set Intel.

The Currently Selected Side field shows the current selected side. This changes when you select a 
unit or side icon on the force list or a unit on the map.

There are three Tab views, namely Scenario, Units and Estabs.

Scenario Tab 

This displays the relevant scenario data. At the top is a Template checkbox. If checked the scenario 
cannot be opened in the Game. Use this to create template scenarios that store order of battles ( list of 
forces ). These can then be Saved As a  normal scenario. See Create a New Template.

The bulk of the tab view is taken up with the Scenario Description field. This contains the text viewable 
when selecting the scenario in the Game. This is usually fairly general. A specific Side Briefing is used 
to convey confidential details for each side.

To enter the Scenario Description:

	 Type and edit the desired text in the field

This is a standard edit text field. It supports copy and paste and will scroll if the text is too long to fit.

Change Command Colour

The Commands box displays the name of each command. There is one for each side. The name is 
copied from the supreme force. To edit the name see Create a New Supreme 
Force. It also displays the background colour of each command. This will be the 
colour used for the command bars of units in the Game.

To edit the colour of each command:

	 Double-click the desired command name

This opens the Command window. 

	 Double-click on the background and/or Foreground colour swatch

	 Select the desired new colour

	 Click OK
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If you want to define your own customised colour:

	 Click on the Define Custom Colours button

	 Click on the desired colour from the rainbow  
pattern or

	 Enter the desired Hue/Sat/Lum values or 

	 Enter the desired Red/Green/Blue values

	 Hit the Add to Custom Colours button

	 Select the new colour swatch from the Custom colours display and 

	 Hit OK on the Colour window

	 Click OK on the Command window

The Foreground colour defines the colour of any text or icons overlaid on the command bar. It’s a good 
idea to use a dark foreground colour on a light background colour or vice versa.

	Changes to the command bar 
colour of units displayed on the 
map will not take place until you 
save and reopen the scenario 
in the ScenMaker.
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The Timing fields are used to set the start, end or duration of the scenario. To edit the start, end or 
duration:

	 Select the desired timing field

	 Edit the text

	 Tab to exit the timing field and confirm

The time and duration fields must be entered using the correct syntax.  The correct time syntax is “dd 
mmm yyyy hh:mm”, where hh uses the 24 hour clock - eg 3.05pm on the 14th of April 1941 equals 
“14 Apr 1941 15:05”. Also the Start must be before the End and vice versa. If not, the text will change 
colour to red.

	 Hit the Apply Timings button.

This will adjust the timings of 
reinforcements and objectives as 
necessary. For details see Timings.

The Map File button displays the current map file. To change the current map file:

	 Click on the MapFile button

This will open the Change Map window.

	 From the list of maps, select the desired map

	 Hit OK

It may take some time but then the Battlemap will refresh 
displaying the new map. Each Unit, Objective and SEP icon 
will be redrawn over the top. If these would now be off of the map, then they will be moved to the 
closest passable location.

The Estab File field displays the current estab file. Note that this can only be set when you create a 
new scenario. There is no way to change it for an existing scenario.
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Units Tab 

The units tab displays a tree list of all 
the units in the game. This behaves 
similarly to the Order of Battle display 
in the Game. Use the + and – icons next 
to units to expand and collapse the list. 
Selecting a unit in the list, also selects 
the unit on the map and vice versa. Right 
clicking on a unit in the list brings up its 
context menu from which you can then 
open its data, create a new subordinate, 
duplicate the unit, delete it or export it 
and/or its subordinates.

To open the unit data:

	 Right click on the unit icon in the list and select Open Unit 
Data or

	 Select the unit in the list and hit Enter or

	 Double-click on the unit’s icon on the battlemap

To create a new subordinate unit:

	 Select the superior unit

	 Right click and select  New Subordinate or

	 Hit Ins

This will create a new unit which will appear as Untitled nested below the 
selected superior.
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To duplicate a unit:

	 Select the unit

	 Right click and select  
Duplicate 

This will create a new unit which will appear below the 
selected unit. It will have the same name and data as the 
originally selected unit.

To delete a unit:

	 Select the unit

	 Right click and select Delete or

	 Hit Delete key

If the selected unit has subordinates you will be prompted to confirm 
whether you also want to delete those subordinates. If so:

	 Hit OK

The selected unit and its subordinates will then be deleted from the 
list.

To export a unit to a force list:

	 Select the unit

	 Right click and select Export

If the selected unit has subordinates you will be prompted to confirm whether 
you also want to export those subordinates. If so:

	 Hit Yes
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If not:

	 Hit No ( this will export only the selected unit )

The Save As window will appear 
prompting you to provide a name for the 
new force list file.

	 Enter a name

	 Hit Save

The selected unit (and its subordinates) 
will then be exported to an xml file. 
This can later be imported into another 
scenario.

To re-subordinate a unit:

	 Drag the unit icon in the list over the top of the new superior and release

The unit will be 
attached to the 
new superior. 
It will retain 
its current 
subordinates. Eg 
if you drag the 
1st Bn to the 2nd 
Bde, then the 1st 
Bn will
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Estabs Tab 

This displays a tree list of 
the side and equipment 
establishments contained in the 
linked Estab file. These estabs 
are available to be used within 
the scenario. The data is in 
read only format and cannot be 
edited.

Side Estabs

The side estabs are organized 
in a hierarchy – side, nation, 
service and unit. Use the + 
and – buttons to expand and 
collapse the various branches.

To view the estab data:

	 Double-click the desired item

Side, nation and service data windows only have one view consisting 
primarily of their name. 

Unit estabs have four different views – Summary, General, Assigned 
Equipment and Assigned Supplies. To change the view:

	 Select the desired view from the 
drop down list

For an explanation of the nomenclature 
used see Annex A - Estab Naming 
Conventions.
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Equipment Estabs

The equipment estabs are of three types – vehicles, weapons and ammo. 
As with the side estabs use the + and – keys to expand and collapse the 
branches and double-click to open their data windows.

Vehicle estabs have four different views – Summary, Description, 
Performance and Armament. Not all vehicles will have armaments. Again 
change the view by selecting it from the drop down list.

Weapon estabs are further divided into six categories – Small Arms, RPG ( rocket propelled grenades 
), Mortar, Gun, Rocket Launcher and Other. They all have two views – Summary and Description.

Note that some weapons may have multiple fire types ( eg anti-personnel, 
anti-armour, bombard ). To change the current displayed fire type:

	 Left click on the Fire Type field.

	 Select the desired fire type from the drop down list 

Changing the fire type will refresh the data including the range table.

Ammo Estabs have just the one view detailing its name and the minimum 
order quantity and weight. These are used in the Resupply system.
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Menus

At the top of the screen is the main menu bar. 

To show the list of items under each menu on the bar:

	 Click on the menu text

To select an item from the menu:

	 Click on the item text

To select an item from a cascading menu:

	 Click on the item text to cascade the menu

	 Click on the item text to select it

File Menu

Like most Windows applications the File menu has items to create a New scenario, 
to Open… and Close an existing scenario, to Save an existing scenario, to Save 
As… under a different name and to Exit the application. Above the Exit item is a 
list of the most recent files opened in the ScenMaker. Selecting one of these will 
re-open it.

Scenario Menu

This has only one item – Weather – which opens the Weather window. This is used to specify the 
historical weather data and the weather probabilities for the non-historical weather options.

See Set Weather for more information.

Import/Export

Use these menu items to export and import a subset of the data of all forces within the scenario. Not 
all data relating to a unit is exported. The data is exported to the clipboard where it can be pasted into 
a spreadsheet for further editing and later importation back into the ScenMaker. For further details see 
Export/Import Force Data to Clipboard.
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Side

For more information on these see – Import Force List, Set Air Availability, Set 
Reinforcements, Set Victory Conditions, Set Supply Schedule, Side Briefing and 
Messages and  Set Initial Orders Delay .

The Side menu is also available as a context menu when right 
clicking on the Side icon in the force tree of the Units tab view.

Unit

The Unit menu is used to set the various values of the selected force(s). Use the 
variation items at the bottom of the menu to specify the amount of variation to 
apply. Then select an item and an option from the sub-menu. The value of the 
option will be randomly adjusted by the variation. 

Eg. If you select Variation +/- 10% and then select Set Experience->70% +/- 
Var, then the resulting value will be somewhere between 60% and 80%. 

If more than one force is selected, then their values will be randomly determined 
separately. So in the above example one unit may end up with a value 63%, 
while another with 77%.

Note that the variation does not apply to the Set Deployment item.

Commander

The Commander menu works the same as the Unit menu, applying a variation 
to the various commander values. Use it to set the commander values of all 
selected units with a specified range.
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Tools

The Tools menu provides access to the two line of sight tools – direct and 
area – and the three pathing tools – for motorised, non-motorised and 
current unit. These tools work as they do in the Game.

View

 The View menus allows you to show/hide unit and objective icons and the 
1km map grid. The Unit Icons sub menu allows you set the type of data 
displayed in the Unit Info Box of all unit icons. 

Help

This simply has one active option – ie to open the About Box. This displays a scrolling credits list on 
the left with the names and many of the faces of those involved in bringing you this great game.
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The Guide
This section answers your questions “How do I?”

Create a New Scenario
There are three ways to create a new scenario:

	 Clone an existing scenario

	 Clone an existing template

	 Start from scratch

Pros and Cons

Starting from scratch provides you with a clean slate. You get to specify the map and estab files to use 
and then you can either import an existing force list, which takes no time at all, or you can create your 
units from scratch, assigning unit types, names, and values, which can take a fair amount of time. If 
you want to start from scratch, just keep reading!

If you want a scenario similar to an existing one, then it is probably easier to just modify that scenario 
directly. You will want to skip to the Clone an Existing Scenario section.

Otherwise, we recommend that you use one of the Force List templates. These start with no forces or 
objectives on map, no reinforcements or air schedules and no victory conditions set. But they do come 
with a list of forces.

You can set the at-start values of individual units, delete existing units, add new ones, rearrange the 
force structure, place those you require on map at start and schedule others to arrive as reinforcements. 
If this sounds like a good option, skip to the Clone an Existing  Template section.

Clone an Existing Scenario

To create a new scenario using an existing scenario:

	 Open the desired scenario

	 Save the scenario under a new filename – ie Save As .

	 Edit as required
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Clone an Existing Template

To create a new scenario using one of the templates:

	 Open the desired template scenario

	 Uncheck the Template checkbox on the Scenario Tab

Un-checking the Template checkbox allows the scenario to be played within the Game.

	 Save the scenario under a new filename – ie Save As .

	 Edit as required

Now you can edit the force list as described in Set Forces. 

Create a New Template

To create a new template scenario:

	 Create a new scenario

	 Check the Template checkbox on the Scenario Tab

	 Save the Scenario ( preferably with the word Template in the title

Start from Scratch

To start your scenario from scratch:

	 Select File > New

This opens the New Scenario dialog.

	 Select CreteEstab from the list on the left

	 Select the desired map from the Map list on the right

	 Select the OK button.
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If you wish to create a new map, you must do so first using the 
MapMaker application. See the MapMaker Manual for more 
information.

Initial Save

A good first step is to save your scenario – see Save a Scenario.

The file name will be the scenario title in the game, so it will be shown in the Scenario Selection 
window and in the Sidebar of the game. Try to make it descriptive, but short enough to fit in the 
Sidebar!

Keep saving every few minutes. This protects you against losing your work.

	Save early and save often
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What’s Next?

From here on you can enter the data in any order you like. However, you may like to follow the 
following sequence:

1.	 Set the Scene

2.	 Set Forces

3.	 Set Reinforcements

4.	 Set Objectives

5.	 Set Victory Conditions

6.	 Set Crossings

7.	 Set Weather

8.	 Set Air Availability

9.	 Set SEPs

10.	 Set Supply Schedule

11.	 Set Orders Delay At Start

12.	 Set Intel

This sequence is also listed in Annex B – Scenario Design Sequence. 
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Set the Scene
Use the Scenario Tab to enter the scenario name and briefings, set timings, set 
Command colours and ( if you need to ) set the Map file for the scenario.

Scenario Briefing

The Scenario Briefing is shown in two places: in the dialog seen by the 
player when selecting a new scenario to play and in the Brief Tab of the 
Sidebar once the game starts.

	 Select the Scenario Tab

	 Type the Scenario Briefing into the Description field.

This is a standard scrolling text field. You can cut and paste and perform the 
usual text editing.

As a general rule, specify any special instructions up front – like “best played first as Axis”. Then follow 
with a short description of what the scenario is about. Remember that both sides can see the scenario 
briefing, so don’t include any information you don’t want one side to have. You can put side-specific 
information in a separate briefing for each side – see Side Briefing & Messages. If you are including 
extra reinforcement schedules so players can adjust the scenario difficulty (see Set Reinforcements), 
you should mention this in the scenario briefing as well.

Side Briefing & Messages

The Side Briefings appear at the top of 
the Brief Tab of the Sidebar in the Game. 
The Victory Messages appear on the AAR 
screen at the end of a Game and vary 
depending on the victory level awarded. 
To set the briefing and messages:

	 Select Side->Briefing from 
the Side menu or using the right 
button context menu

	 Enter the desired text in the 
respective fields.

	 Hit OK
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Set Supreme Commander Details

On the Side Briefing window there are three fields for setting the name, title and signature of the 
Supreme Commander. These appear on the AAR screen at the end of the game. To enter the Name and 
Title:

	 Enter the desired text in the respective Name and Title fields

	 Hit OK

To specify the signature graphic to use:

	 Click on the Browse button to the right of the Signature field

This will open the file selection dialog.

	 Browse and select the desired graphic file ( 256 colour bmp format )

	 Click Open
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    Timings

You can adjust the start, end or duration of the scenario. To do so:

	 Select the desired timing field

	 Edit the text

	 Tab to exit the timing field and confirm

The text will highlight in red if 
the format is incorrect, the end 
time is before the start time, or 
the scenario duration will be too 
long for the game to handle. You 
need to enter the times exactly 
as they are written to start with, 
including punctuation. Often the timings will go red while you are typing them in, this is normal – if 
they are still red when you have finished, however, then you have either set an invalid duration or used 
the wrong format when typing them in.

If you change the timings after having created your objectives and/or reinforcement schedules, you 
must select the Apply Timings button to update objective and reinforcement timings to ensure they 
are within scope.

	 Hit the Apply Timings button.

This will adjust the timings of reinforcements and objectives as necessary. Essentially it determines 
the offset between the original timings and the new ones. It then applies this offset to all the timings. 
Where the offset would push the time out of bounds it will be constrained to the new start or end. In 
some cases the resulting times may not be what you want. So it is recommended that you:

	 Always check and adjust the reinforcements and objective timings after 
you change the scenario start or end time

	Although you set reinforcements by specifying their position within the scenario (e.g. D2, 18:00), 
the game actually records them using the full date (e.g. 12 Apr 1941 18:00)

Command Colours

For details on how to edit the colour of each command see Change Command 
Colour.
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Map

To change the current map file:

	 Click on the MapFile button on the Scenario tab 
view

This will open the Change Map window.

	 From the list of maps, select the desired map

	 Hit OK

It may take some time but then the Battlemap will refresh displaying the new map. Each Unit, Objective 
and SEP icon will be redrawn over the top. If these would now be off of the map, then they will be 
moved to the closest passable location.

	 Make sure you check the location of all units, objectives, and reinforcements after changing the 
map – see Set Forces, Set Objectives, and Set Reinforcements for details

Situation Awareness Map (SAM)

To change the current SAM file:

	 Click on the SAM File button on the Scenario tab view

This will open the Select SAM window. It’s a standard file selection window.

	 Navigate to the desired Scenarios 
SubFolder

	 From the list of SAMs, select the 
desired one

	 Hit Open

The name on the button should change to 
reflect the new SAM name.
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Set Forces
The forces of both sides make up the Force List. Each side has a Supreme Force and then one or more 
subordinate units. These are displayed in the Units tab view in a tree list similar to the Order of Battle 
display in the Game.

If you are cloning an existing scenario or template, then you will already have some forces for each 
side. If you are starting the scenario from scratch, then you need to create these. In which case, the first 
thing you need to do is to create a Supreme Force for both sides.

Create a New Supreme Force

The Supreme Force is the most senior unit in the force list for each side. Once created, it cannot be 
deleted or moved, but you can edit it, including changing the estab it uses ( so if you started using a 
divisional HQ estab, you could later upgrade it to use a corps HQ estab and rename it ).

	The Name of the supreme force is shown on the Play As button when you are setting up a 
scenario in the game

To create a new supreme force:

	 Select the Units Tab

The only thing on the Units Tab is a big tree window called the Force List. 

	 Right-click on the Axis ( or Allies ) icon and select New Supreme 
Force from the context menu, or 

	 click on the icon and press the Insert  key 

Note that on some keyboards the Insert key is part of the Function or F-Keys 
and only works when F-Keys are toggled off. 

A unit (called “Untitled”) will now appear in the force list, directly under 
the Axis icon. Now you need to edit the details of that unit to something 
meaningful.
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Edit Unit Data

The first thing to do is to assign an estab. As explained in What’s an Estab?, estabs determine the 
personnel, equipment, size, and capabilities of the unit. These steps are the same for every unit, not 
just the supreme forces.

First, we need to open the Unit Data window:

	 Right-click the unit icon in the force list and select Open Force 
Data, or

	 Double-click the unit icon in the force list, or

	 If the unit appears on the Battlemap, double-click the 
unit icon on the Battlemap

As you can see, there is room for all sorts of data to flesh out 
the identities of your units. For now, we need to set the type 
of unit by assigning an estab to it. Let’s take a look at the 
selection to choose from:

	 Select the Estabs Tab in the Sidebar

	 Expand the list by clicking on the + box next to Sides, then the one 
next to Axis, followed by the one next to Germany and finally the one 
next to Luftwaffe

	 Select the desired Estab - eg the 1m-lw-Fliegerkorps HQ

To view the details about the different estabs:

	 Double-click on them

This opens an Estab Unit window containing various pages of information 
about the estab. See Estabs Tab to learn how to read this stuff.
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Once you’ve decided what estab to use:

	 Drag an estab and drop it on the Estab field of the Unit Data window.

Estab Names

The standard estabs all follow a consistent naming convention that 
helps you to identify them without having to open them up. Here’s 
an example:

	WF - GDS - 17pdr AT Tp

The first part (WF) indicates the theatre of war or set of estabs. In this 
case WF stands for West Front. The second part (GDS) indicates the 
side/service. In this case GDS stands for British Guards. The third 
part (17pdr AT Tp) is the description, which is usually in the form 
of unit type plus size. In this case 17pdr AT Tp means a 17 pounder 
anti-tank troop. If it’s a HQ then this is appended at the end. Eg WF 
- US - Army HQ.

You can learn those conventions by referring to Annex A - Estab 
Naming Conventions and by reading the Unit Names section in the 
Game Manual; abbreviations are explained in the Glossary of the 
same manual.
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Unit Name and Designation

Now you’ve assigned an estab, you should set the unit name 
(which will be displayed when the unit is selected in the game) 
to something that reflects the unit type. For example, if you 
picked the 1m-hr-Korps HQ estab, you could call the unit  
something like “XXXX Armeekorps HQ” or “XXX Inf 
Korps HQ”. To set the unit name:

	 Click in the Name field on the Unit Data window 
and type the name (keep it short enough that it will fit 
in the Sidebar when loaded in the game)

The Designation is the text that will appear on the unit icon. 
To set this:

	 Double-click the right-hand unit icon in the Unit 
Data window

	 Enter the desired designation and select OK.

If you were calling the unit “XXXX Armeekorps HQ” you 
could use a designation like “XXXX”. You can enter a 
maximum of 5 characters or digits. You can use the following 
punctuation:

Table 1 – Allowable Designation Symbols

Symbol Name Usual Use

- Dash not usually used
, Comma not usually used
/ Forward slash usually used between battalion and regiment
. Period usually used between company and battalion or company and regiment



SCENMAKER MANUAL

38
© 2010-2017 Panther Games. All rights reserved. Command Ops is a trademark of Panther Games. All other trademarks and trade names 
are the properties of their respective owners and Panther Games makes no claim thereto.

Unit Strength, Status and Quality

The next step is to set up the current strength, status and quality of the unit and its commander.

	 Enter a percentage from 1 to 200 in the % of Estab field (recommended), or a 
number of personnel in the Personnel field, in the Unit Data window

This determines what percentage of the estab manpower, equipment, and supply levels are actually 
present in the unit. For example, if the estab specifies 50 men, 45 rifles and five sub-machineguns, 
entering 60 in the % of Estab field will give the unit 30 men, 27 rifles, and three sub-machineguns. 
Specifying a number of personnel does roughly the same thing, but going in the other direction; if you 
set the Personnel field to 40 for our hypothetical 50-man estab, then the % of Estab field would be set 
to 80, and you’d get 36 rifles and four sub-machineguns.

The following fields all affect unit characteristics that are described in the Game Manual. Check out 
the section on Units for a detailed description.

	 Enter a percentage from 1 to 100 in the Staff Qual % field.

This determines how effective the unit is going to be at processing orders and also helps determine 
its Staff Capacity (which is shown immediately above in a read-only field). The default value is 100, 
which produces a very efficient unit that suffers little orders delay and can command many other units. 
An average unit should have a Staff Qual % of around 50; a poor unit should have 30 or even less.

	When you change the Personnel, % of Estab, 
and Staff Qual % fields, you will not see changes 
in the other fields until you close and reopen the Unit 
Data window

We can now enter a whole heap of other information about 
the unit.

Don’t forget to set the Deployment field as well. You can even 
enter a short history of the unit in the Unit History field.
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Commander Quality

You can set the details for your unit commander on another page of the Unit Data window:

	 Select Commander from the pull-down menu at the 
top left of the Unit Data window

	 Enter the unit commander’s name, rank, and 
effectiveness values, and

	 Write a short biography of the commander if you 
desire.

Now you’ve finished setting up the unit!

	 Click OK to close the Unit Data window and save your changes

	 If you are working on a scenario right now, this is a good time to save it again

Create New Subordinate Units

Now that you have your supreme force sorted out, you need to start creating the rest of the order of 
battle. The units that you create now will be a bit more flexible than the supreme force; you can edit, 
delete, and duplicate these units and you can drag them around to put them under new commanders.

Create from Scratch

To create a new unit from scratch:

	 Identify an existing unit in the Force List to be the superior for your new unit

	 Right-click on that unit in the Force List and select New 
Subordinate from the popup menu, or select the unit in 
the Force List and press the Insert    key

	Note that on some keyboards the Insert key will only work if 
the F-Keys are turned off.

A new Untitled unit will appear selected in the list.
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	 Double-click on the new Untitled unit to open the Unit Data dialog.

Now you can 
edit the details 
of your new 
unit, including 
assigning an 
Estab, just like 
you did for the 
supreme force in 
Edit Unit Data.

Duplicate Existing Units

You can speed up the process of creating forces by duplicating units you have already created. To 
duplicate an existing unit:

	 Right-click on a unit in the Force List and select Duplicate from the popup 
menu

If the unit being duplicated has subordinates, a dialog will open asking if 
you want to duplicate the sub-units as well.

	 Select Yes or No to select whether or not to duplicate subordinates 
or select Cancel to abort without duplicating any units

The new unit or force will be subordinated to the original unit’s superior. It will be selected and appear 
at the bottom of the superior’s list of subordinates.

You can then edit the data of the new unit(s) - see Edit Unit Data.

When you duplicate a unit, the new unit will have exactly the same name, designation, estab, and 
values as the original unit, with three exceptions:
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	The Unit History of the new unit will be blank

	The Commander Name of the new unit will be 
blank

	The Commander Biography of the new unit will 
be blank

If you want to copy these details as well, you will need 
to open the Unit Data window of the original unit(s) and 
use the standard Windows Copy and Paste functions to 
transfer the information.

Delete Units

There are two restrictions on deleting units:

	You cannot delete the supreme force of either side

	You cannot delete a unit that has subordinates without also deleting all the subordinates

To delete a unit from the scenario:

	 Right-click on the unit in the Force List and select Delete from the popup menu, 
or

	 Select the unit in the Force List and press the Delete   key

If the unit has no subordinates it will be removed from the list and destroyed. If the unit has subordinates 
you will be asked to confirm to delete the selected unit and all its subordinates. 

	 Click OK to delete them all or 

	 Click Cancel to abort

	WARNING – deleting units is permanent – THERE IS NO 
UNDO

Always save your scenario before deleting units, so you can restore the earlier version if you delete a 
unit that you still need.
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Re-subordinate Units 

To assign a unit to a new superior:

	 Drag the unit in the Force List onto its new superior in the Force List

Any existing subordinates of the dragged unit will remain with it after subordination. Essentially, you 
move everything under the unit – so if you place a battalion under a different brigade HQ, all that 
battalion’s companies and platoons will move with it.

If the new HQ you want to use is out of sight off the top or bottom of the force list:

	 Drag the subordinate unit near the top or bottom of the Force List, which will then slowly scroll 
up or down; or

	 Drag the subordinate unit a short distance up or down then move the mouse wheel up or 
down to bring the desired new HQ unit into view

Restrictions on the Command Structure

There are some restrictions that you should observe when creating your command structure.

	Do not subordinate a unit with a larger force size to a unit with a smaller force size

Eg, do not place a brigade HQ under a battalion HQ. If you do this, you will receive an error message 
when you start the scenario in the game. The error message will specify the units you need to change.

	It is recommended ( for the AI’s sake ) that you do not structure your forces such that a HQ has 
just one subordinate HQ
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For example, in this screenshot, Flieger Div 7 HQ has only the FJ Regt 3 HQ 
under direct command. This is not good for the AI. In this case, it would be 
better not to have the Flieger Div 7 HQ at all – just the FJ Regt 3 HQ, with 
the arty and flak units subordinated to the FJ Regt 3 HQ.

Export / Import Force Data to Clipboard

To speed up global editing of force data, you can export data on all units in the force list to the clipboard 
in a tab-separated values format. You can then copy this into an editing or spreadsheet program like 
Microsoft Excel® and edit the values. These can then be imported back into the ScenMaker.

To export:

	 Select 
Import / Export > Export 
Forces To Clipboard

To import:

	 Select Import / Export 
> Import Forces From 
Clipboard

Not all data is exported. Table 2 shows 
exactly what is included and left out.

The imported data will overwrite any 
data in the game. 

	 You must NOT add or 
delete any units between 
exporting the data and 
importing it again

WARNING – When you export to a 
spreadsheet, designations in the format 
“1.10” (as in 1st Eng Coy 10th SS Pz 
Div) will often be treated as a number, 
causing the final “0” to be truncated 
when pasted into Excel  (i.e. to “1.1”). 
Ensure that you set the Designation 
column to Text (rather than number 
format) and check the entries before 
importing back into the ScenMaker. 
Consult your spreadsheet program help 
for details on how to do this.

Table 2 – Data Included in Export / Import

Data Included in Export / Import?
Name Yes
Designation Yes
Estab No
Personnel No
% of Estab Yes
Staff Cap No
Staff Qual % Yes
Cohesion Yes
Fatigue Yes
Morale Yes
Experience Yes
Fitness Yes
Training Yes
Aggro Yes
Stubbornness Yes
Deployment Status Yes
Unit History No
Equipment Types and Numbers No
Basics, Fuel, Ammo, and Bridges No
Cmdr Name No
Rank No
Leadership Yes
Aggression Yes
Determination Yes
Efficiency Yes
Judgement Yes
Biography No
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ScenMaker Excel Tools Package

A utility package containing Microsoft Excel templates and add-ins is available from the Matrix 
Games website – use these templates to minimise problems with designations, and to make adjusting 
values easier and faster. This package is not supported by Panther Games, however.

Export / Import Force Lists

You can speed up the process of creating forces by exporting units that already exist in one scenario, 
and importing them to another scenario. To export an existing unit or force:

	 Right-click on a unit in the Force List and select Export from the popup 
menu

If the unit being exported has subordinates, a dialog will open asking if you 
want to export the sub-units as well.

	 Select Yes or No to select whether or not to export subordinates or 
select Cancel to abort without exporting any units

	 Enter a filename in the 
Save As dialog that appears

The unit and, if appropriate, any 
subordinates, will be exported to an 
Xtensible Markup Language (XML) 
format file using the name you enter.

To import a saved force list into an existing scenario:

	 Right–click on the Axis or Allied side icon in the Force List

	 Select Import Force List from the pop-up menu
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	 Double-click the force list 
file containing the unit(s) you want to 
import  or

	 Select the force list file 
containing the unit(s) you want to 
import and select Open.

A check will be made to ensure that 
you only import Allied forces to the 
Allied side, and Axis forces to the 
Axis side. If correct, you will be 
advised.

The forces contained in the selected file will be 
created in your scenario, in their original command structure, as direct 
subordinates of the supreme force of the appropriate side. 

If you attempt to import units to the wrong side you will 
receive an error message and the import will not take 
place:

 	 Hit OK and try again.

Saved Force Lists are a convenient way of creating discreet building blocks that can 
be used to develop scenarios quickly. Eg. if you save separate force lists for each Division you can 
quickly construct or modify a scenario with different orders of battle.

Bases

In order to ensure that your units receive supplies during a game, you should always create a base unit 
(that is, a unit which has one of the Base estab types assigned to it) as part of every force higher than 
battalion level.

	You should only create one base at each level of your force

For example, a division should have one divisional base directly under the command of the divisional 
HQ, and it should have one brigade base directly under the command of each brigade HQ.

You should use bases of the same level and type as the force they are supplying.

For example, a British armoured division should include base units with these estabs:
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	One 1m-uk.ad-Arm Div Base, under direct command of the Arm Div HQ, and

	Two 1m-uk.ad-Arm Bde Base, one under direct command of each of the two Arm Bde 
HQs

If you were to also place an infantry brigade under the divisional HQ, you would include the following 
additional base:

	One 1m-uk.id-Inf Bde Base, under direct command of the Inf Bde HQ

If a unit’s superior HQ does not have a Base, it will search up the chain of command until it finds a 
superior that does have a Base and draw from it. This may end up overloading the Base and reducing 
its efficiency to resupply. If there are no bases at all for a given side, then no unit on that side will 
be resupplied. This may be OK for a short one day scenario but for anything longer it is strongly 
recommended that you provide suitable Bases.
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Set Reinforcements
A scenario does not necessarily have to have reinforcement schedules – all forces could start on-map. 
However, for most scenarios one or both sides will require at least one reinforcement schedule. 

These come in three different types – Standard, Favour Us, and Favour Them. These correspond to 
the reinforcement schedule settings selected by the user in the New Scenario Options window of 
the game. For example, a Favour Us schedule for the Axis side is used when the Favour Axis type is 
specified for the Axis reinforcements.

For each type there can be many schedules, one of which will be randomly selected at start-up of the 
game. In this way it is possible to specify multiple arrival locations and/or times for the same force, so 
that playing the scenario will be different from one game to the next. 

Essentially a schedule is a container for reinforcement units and forces; each schedule holds a set of 
units or forces and their arrival times, types, and locations. When the scenario starts and a schedule is 
selected, the entries it contains are shown on the Reinf Tab on the Sidebar.

Display the Reinforcements Window

To start setting reinforcements for a side:

	 Right-click the desired Side Icon in the Force List and select 
Reinforcements from the pop-up menu, or

	 Select the side in the Force List and select Reinforcements 
from the Side menu

This opens the 
Reinforcements 
window for the 
selected side. If 
you are creating a 
new scenario from 
scratch or cloning 
a template then this 
will be blank.
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Create a New Schedule

To create a schedule:

	 Click the Add 
button 

	 Replace the text 
in the combo 
box at the top 
left with the 
desired name

You can also specify the schedule type: Favour 
Us, Standard (the default), or Favour Them.

	 Set the Type in the pull-down menu at 
the top right

If you create a Favour Us or Favour Them schedule, but no Standard schedule, then the New Scenario 
Options window in the game will default to whichever schedule does exist. This may be undesirable; if 
so, create a Standard schedule and simply don’t add any units to it. This way the New Scenario Options 
window will default to Standard when the scenario is selected in the game.

Add Units to Schedule

Set Unit

To make a unit into a reinforcement:

	 Drag the unit from the Force List onto the main area of the Reinforcement window 

The unit will appear as a new line in the window. If the unit has subordinates, they will arrive in the 
same place and at the same time as the unit in the window, unless:

	They are already on the map or

	They are placed in the same reinforcement schedule as a separate entry
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Set Arrival Location

To set the arrival location of the 
unit:

	 Drag the unit from the 
R e i n f o r c e m e n t 
window onto the 
Battlemap and drop 
it at the desired arrival 
location

In the Reinforcement window, 
the Location field for that unit 
will be filled in with a set of 
coordinates (measured in metres 
from the top left corner or the 
map).
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Set Arrival Type

	 Set the Arrival Type using the pull-down menu in that field

The available arrival types are:

Set Arrival Times

	 Set the Earliest Time and Latest Time

The unit will arrive at a random time between the earliest and latest times set (inclusive). The values 
in these fields need to be entered in the exact format shown in the screenshot:

Table 3 – Reinforcement Arrival Types

Arrival Type Meaning and Effect

Ground

Units arriving by road or already in place:
No effect on cohesion
Minimal dispersion
No casualties

Para Drop

Units arriving by parachute:
Cohesion greatly reduced
Great dispersion
Casualties if not arriving on smooth terrain

Bad Para 
Drop

Units arriving by parachute using the German technique:
Cohesion very greatly reduced with reduced recovery rate
Reduced initial firepower ( first hour )
Great dispersion
Heavy casualties if not arriving on smooth terrain

Glider Drop

Units arriving in crash-landed gliders:
Cohesion greatly reduced
Great dispersion
Heavy casualties if not arriving on smooth terrain

Aircraft

Units landing in aircraft:
Cohesion reduced
Minimal dispersion
No casualties

No Show See No Shows
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Set Arrival Strength

You can also modify the strength of units 
arriving as reinforcements. To do so:

	 Enter a value greater than zero in the Min and Max fields.

The Min and Max fields each contain a percentage value; when this value is greater than zero, the 
strength of all units in the reinforcement will be modified by a random percentage between the two 
values. For example, if a unit’s % of Estab (set in the Unit Data window) is 50%, and it is placed on a 
reinforcement schedule with a Min of 10% and a Max of 50%, when it arrives, it will have a strength 
of between 5% and 25% of its estab. 

If you leave these fields at zero, or enter 100 in both, then the unit(s) in that reinforcement entry will 
all arrive at the % of Estab strength set in their Unit Data windows.

No Shows

As noted above, when a unit appears on the reinforcement list, all its subordinates will arrive on 
the map with it, unless they are already on the map or have their own, individual entry on the same 
reinforcement schedule. If you don’t want the subordinates to arrive at all:

	 Add them to the reinforcement schedule

	 Set their Arrival Type to No Show.
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Remove Units from a Schedule

To remove a unit from a reinforcement schedule:

	 Select the unit on the reinforcement window and click the Remove button, or

	 Select the unit on the reinforcement window and press the Delete    key

Warning!

	Do not delete units from the Force List while the Reinforcement window is 
open – this can cause the ScenMaker to crash, causing you to lose your work.

Delete a Schedule

To delete the current schedule:

	 Click the Delete button on the Reinforcement window

This will destroy the current schedule and select the next available one.

Duplicate a Schedule

To duplicate the current schedule:

	 Click the Duplicate button on 
the Reinforcement window

This will copy the current schedule, including its type and all its entries, renaming it with the prefix 
“Copy of”.

Activate/Deactivate SEPs

For each reinforcement schedule you can specify which of the Supply Entry Points ( SEPs ) will 
be active for that schedule. In this way you can synchronize the SEPs with the arrival locations. By 
default all SEPs will be activated when you create a schedule. This is indicated by the numeral “1” in 
the Active column. 

http://aa.usno.navy.mil/data/docs/RS_OneYear.html
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To deactivate an SEP:

	 Enter the numeral “0” in the active column next to its SEP #.

To activate an SEP:

	 Enter the numeral “1” in the active column next to its SEP #.

Special Tricks Using Reinforcements

Reinforcements are useful in creating certain special effects in your scenarios. For example, to change 
the positioning of units that will start the scenario already on the map, create a Standard reinforcement 
schedule for each different start location. Add the units as reinforcements with Earliest Time and 
Latest Time both set to the scenario start and set their Location so they are placed differently in each 
scenario. The units will always appear on the map at scenario start and in different places depending 
on which randomly-selected schedule is active for that game.

	If all units for a given side arrive as reinforcements, then at least one unit must arrive at scenario 
start ( ie. its start and end time must be set to scenario start ).

You can also use the Min and Max fields to set different strengths for the same unit in Favour Us and 
Favour Them reinforcement schedules. If you want the schedule to favour that side, increase the Min 
and Max values; to favour the other side, reduce them.
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Set Objectives
Objectives or Side Tasks drive the AI’s planning. The type location and other properties of objectives 
will determine how, when and where the AI controlled side conducts its operations. They also serve as 
the goals for the human player.

A scenario can have as few as one per side or you can assign quite a number to be active simultaneously 
or in sequence. The more concurrent objectives the greater challenge for the human player as he will 
have to balance priorities and allocate forces. On the other hand, avoid having too many. As a general 
rule, have no more than a dozen active objectives at any one time per side.

	Each side must have at least one objective active throughout the scenario

Objectives will be either victory objectives or AI objectives. A victory objective has VPs assigned via 
the Victory Conditions window – see Set Victory Conditions. Only victory objectives appear in the 
Objectives list in the Game. An AI objective has no VPs assigned and only affects the AI controlled 
side. Use these to help the AI controlled side develop a good strategy.

Place Objectives

To place an objective on the Battlemap for the currently selected side:

	 Click one of the Objective Buttons on the Sidebar or press it’s keyboard shortcut

	 Click on the map where you want to place the objective.

This will place an 
objective of the 
selected type in the 
selected location, 
referred to as the 
objective location or 
ObjLoc. If you click 
on an impassable 
area of the map, the 
objective will snap to 
the nearest passable 
location.
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Avoid placing Exit objectives on the map 
edge where the grid is within 200m of the 
map edge. In such cases, shift the location 
300m in from the edge into the next grid. 

Edit Objectives

You can edit a number of the properties of each objective. To edit an 
objective’s properties:

	 Double-click the Objective Icon on the Battlemap

You can edit the following properties:

Table 4 – Objective Properties

Property Meaning

Title Short description

Type Sets the achievement conditions for the objective

Start AI will start allocating forces to the objective at this time

End Objective becomes inactive at this time
Completion points are awarded at this time

HHour
Objective becomes active at this time
Available occupation points start to decrease from this time
AI may use Fastest Speed between Start time and HHour time

Priority See AI Objectives

Radius Sets radius of objective perimeter

AI Should 
Rebuild Bridge

For Secure Crossing objectives only:
Means the objective can still be achieved if the bridge is blown and rebuilt
AI will only build bridges where this box is checked
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Objective Type

The types of objectives are limited to Defend, Secure, Secure Crossing, Deny Crossing and Exit. When 
in doubt use a Secure type. This will require the side to ensure that it maintains enough force within 
the objective perimeter to achieve a 10 to 1 force ratio with any enemy units within the perimeter. In 
other words it is “pro-active”. 

Secure Crossing is similar but also requires that the side maintains the level of the nearest crossing 
( within 500m ) – eg. If it is a medium road bridge at scenario start then the side must ensure it is at 
least a medium road bridge throughout the occupation time and at the completion time. If the bridge is 
demolished it will need to rebuild it before it can gain victory points.

Deny Crossing requires that the side prevents the enemy from securing the nearest crossing. It will see 
the crossing primed and demolition attempted if the enemy comes too close.

Exit requires the side to exit units equal to the specified anti-personnel and bombardment firepower 
and the specified armour values by the completion time.

Defend is best reserved for AI objectives. This requires the side to maintain a unit within the perimeter 
for the duration. Use this to assist the AI to hold vital ground to delay the enemy or help protect a 
victory objective.

Timings

The Start time must be before or equal to the End time and the End time must be equal to or later than 
the Start time. HHour must be somewhere between the Start and End. The default is equal to the Start. 
It is recommended that HHour remains the same as Start time unless you have a very good reason. 

Priority

This only applies to AI objectives and is used to allocate forces. In most cases it is best left at Minimum. 
Avoid setting it too high as a disproportionate amount of forces will be allocated to it rather than to 
victory objectives.

Radius

The default is 500m. Avoid overlapping perimeters. Do not reduce below 500m for Exit objectives.
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Set Victory Conditions
Objectives and victory conditions are at the heart of scenario design. An objective becomes a victory 
condition when you assign certain victory related data to it. This is done in the Victory Conditions 
window, which will list all objectives for the current side.

To display the Victory Conditions dialog for the current side:

	 Right-click the Side Icon in the Force List and select Victory Conditions from the 
pop-up menu, or

	 Select the side in the Force List and select Side > Victory Conditions

The main area of the dialog contains a list of every objective for that side. Selecting an entry in the list, 
also selects the objective icon on the Battlemap. On the left hand side are columns depicting the title, 
type, timings and perimeter radius. These are read only fields. To edit the data in these you need to open 
the respective objective data window. To do so:

	 Double-click the desired objective entry in the list.

Note you may need to reposition the window if it obscures the Objective Data window.

On the right hand side of the list are editable columns for setting the Achievement Points, Exit 
Requirements, Auto End and Links. To the right of the list are the total fields and those for specifying 
the APs assigned for killing enemy units. 

Achievement Points

Achievement Points (APs ) determine the amount of victory points gained for completion ( CompAP 
) and occupation ( OcupAP ). Completion APs are awarded when the objective is completed, either 
by some condition ( eg bridge demolition ) or at the End time of the objective. Occupation APs are 
awarded every minute that the objective is “achieved”. The amount awarded each minute is determined 
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by dividing the amount of OcupAps by the total active duration of the objective – ie from HHour to 
End. Eg. If OcupAps equals 12,000 and the objective runs from 0800 to 1000hrs ( ie 120 minutes ) then 
the value awarded each minute would be 100.

Given that objectives will often run over many days and thus their active duration will be measured in 
thousands of minutes, it is recommended you set OcupAps in thousands. 

To set CompAPs and OcupAPs:

	 Click in the desired field

	 Enter the desired numeric value

You can enter any numeric value you like in these fields. 

The total achievement points are calculated and displayed in the Total Kill Points, Total Objective 
Points and Grand Total fields to the right of the list. In the Game these will normalised by the value 
set in the Points for 100% Victory field at the right of the list. Eg. if the Points for 100% Victory is 
set to 100,000 and you have assigned 20,000 points to a particular objective, then it will be worth 20 
victory points ( VPs ).

Typically you will set the Points for 100% Victory at a fraction of the Grand Total. That way you will 
provide scope for the player to determine which objectives to go for. Also remember that rarely will a 
side be able to achieve all the occupation points available. You won’t go too far wrong if you set the 
Points for 100% Victory at around two thirds of the Grand Total.

	You cannot set OcupAps for Exit objectives

Killing Enemy 

All scenarios have an extant victory condition for killing enemy. To specify how 
many APs this is worth:

	 Enter the desired value into the Total Kill Points field

The amount entered is divided by the side’s total active personnel quantity. This is determined at game 
start and includes all those on map plus all scheduled reinforcements. Eg if Total Kill Points equals 
20,000 and the total persQty equals 10,000 then 2 points will be awarded for each personnel killed.

A cap can be placed on the Total Kill Points by specifying a value in the % of enemy to kill field. 
Eg. if set at 20% then no points will be awarded after the enemy side has lost 20% of its total active 
persQty. So in a scenario where you want the player to focus on territorial objectives set this field to a 
low value – eg 20%.

	Setting the Total Kill Points value to zero will effectively remove this victory condition. 
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	It is not recommended that a side get all its points from killing the enemy. So have at least one 
other victory objective.

Exit Requirements

Exits are handled differently to other victory conditions. Firstly, they can only 
have completion points assigned. Their OcupAps field is read only. Secondly, 
they have  three additional “requirements” fields that specify the amount of anti-
personnel firepower ( Aper ), armour value ( Arm ) and Bombard firepower ( 
Bomb ) that must be exited. 

To set the requirements:

	 Enter the desired values in the Aper, Arm and Bomb fields

The amount of points awarded each time a unit is exited is determined by totalling its APer, Arm and 
Bomb values and then dividing this by the total requirement values set in the list and then multiplying 
that by the completion points. Eg. a tank company with 20 Aper, 80 Arm and 0 Bomb is exited. The 
requirements for the objective are 500 Aper, 400 Arm and 100 Bomb. The CompAPs are 5000. The 
points awarded equals ( 20 + 80 ) / ( 500 + 400 + 100 ) = 10% * 5000 = 500.

Points will continue to be awarded in the game while any of the requirements remain unfulfilled. 

Auto End

The default for this field is “false”. If this field is set to true then the game will automatically end when 
the victory condition is completed. To set it:

	 Select the desired state ( true or false ) from the drop down list.

This places a lot of pressure on the opposing player to prevent this condition from being completed. 
Use this cautiously. While it can be applied to any objective type, it is not recommended for Defend 
objectives as this will fire the first time a friendly unit enters the perimeter. It is probably best to restrict 
this to Exits. 

Link

The default for this field is “0”, which means “no link”. If a 
number other than zero is entered then the field is linked, 
provided there is at least one other objective with the same link 
number. To link two or more objectives:

	 Set the value of their link fields to the same non-zero 
number ( Eg “1” )
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Note that once linked the achievement points are consolidated such that the maximum values assigned 
to any of the linked objectives is used and displayed only in the first linked entry.

	Only objectives of the same type can be linked

If you try to link objectives of different type, you will receive a 
warning.

	 Click OK and ensure you link objectives of the same type

Where two or more objectives are linked the player can choose which one to go for in the game. Eg if 
two exit objectives are linked then exiting forces at either will suffice to achieve the points on offer. If 
two Secure Crossing objectives are linked, then the player need only secure one of them.

Linking objectives is a good way of providing the friendly player with options while at the same time 
increasing the concerns of the enemy player – ie he has to prevent all linked objectives, while the 
friendly player only has to achieve one of them.

AI Objectives

An AI Objective is one where no achievement points are assigned. These will still appear in the Victory 
Conditions window with zero CompAP and OcupAP values.

AI objectives are used by the AI controlled side in developing its strategic plan. In doing so it allocates 
forces to objectives based on a priority ranking. This is determined for victory objectives using their 
remaining achievement points. For AI objectives it is determined using their Priority value set in the 
Objective Data window.

	Set AI objective Priority values to Minimum or Low.

If you set them too high then too many units will be allocated to AI objectives instead of to the victory 
objectives. It is recommended you initially set their priority to Minimum.

	Do not use Exit type for AI objectives

	Do not set Auto End to true for AI objectives

	Do not link AI objectives
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Set Crossings
When a map is created in the MapMaker crossings are represented by a line. In the ScenMaker these 
are represented by a special crossing icon – the same as used in the game. While you cannot create, 
move or delete them, you can change their type and prime and un-prime them in the ScenMaker.

Prime/Un-prime

To prime and/or un-prime a crossing:

	 Double-click on its icon

This will toggle the priming state – ie an unprimed 
crossing will become primed and vice versa. The 
background colour of a primed crossing is pink, 
while it is white for an unprimed crossing.

If you are designing an historical scenario and 
you know from sources that it was primed or 
unprimed, then set it accordingly. If unsure leave it unprimed. If you are developing a what if scenario 
and a side has a Deny Crossing objective and you want them to be in a position to blow that crossing 
from the start of the game, then prime the crossing in the ScenMaker. Otherwise leave it unprimed.

Change Level

To change the type or level of crossing:

	 Hold the Shift key down and double-click the icon

	 Repeat until the desired level is displayed

There are five levels, namely potential crossing, ferry or ford, minor 
road bridge, medium road bridge and major road bridge. You cannot 
change a road crossing to a rail bridge. However you can change a 
rail crossing to a road bridge.

	Changing the level automatically un-primes the crossing.



SCENMAKER MANUAL

62
© 2010-2017 Panther Games. All rights reserved. Command Ops is a trademark of Panther Games. All other trademarks and trade names 
are the properties of their respective owners and Panther Games makes no claim thereto.

Confirm Crossing

It is very important that all intended crossings are confirmed as valid. Otherwise you will have motorised 
units crossing rivers where they shouldn’t or not being able to cross where they should.

To do so:

	 Select the Best Path for Motorised Units > Shortest from the Tools 
menu

	 Click on a start location a short distance from one side of the 
crossing

	 Click on an end location a short distance on the other side

If a route is drawn across the crossing, then it is valid. However, you 
also need to verify that the adjacent river is not crossable except at 
the crossing. To do so:

	 Click on a start location some distance from one side of 
the crossing

	 Click on an end location on the other side opposite the 
start location

The route should go via the closest crossing as in the above 
example. If it doesn’t or the crossing is not valid then you need 
to edit the river and/or crossing in the MapMaker – see the 
MapMaker Manual. 
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Set Weather
Weather can have a significant effect on game play, primarily on visibility and ground condition. 
Visibility affects sighting, which affects detection and firing. The poorer the visibility the less likely 
units will be detected and fired upon. Ground Condition affects movement. Poor visibility reduces the 
availability of air strikes.

In the Game the player(s) can choose what weather to use. The default is “historical” weather. They 
can however choose to use seasonal, better or worse weather. All these are set in the ScenMaker via 
the Weather window. To open the weather window:

	 Select Weather from the Scenario menu

On the 
left is the 
Historical 
w e a t h e r 
and on the 
right are 
fields used 
to set the 
Seasonal, 
Better and 
W o r s e 
weather. 

Historical Weather

The Historical Weather view consists of a list of entries for each day of the scenario. For each day 
you can specify the weather pattern, the ground condition, sunrise, sunset, minimum temperature and 
maximum temperature. 

Weather Patterns

The weather patterns are hard coded and determine whether it will be sunny, raining, snowing, foggy 
etc. The default is a clear pattern, which produces dry sunny conditions. Other options are Fog ( in the 
morning ), Rain ( throughout ), Late Rain ( in the afternoon/evening ), and Snow ( throughout ).

To choose a pattern:

	 Select the desired pattern from the drop down list.
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Ground Condition

To set the ground condition:

	 Choose the desired condition from the drop down list.

The ground condition can be 
Normal, Muddy, Quagmire, Snow 
or Ice. Their effect on movement 
varies with the Move Type of units 
as per the adjacent table.

Sunrise and Sunset

These times dictate the daylight hours. Dawn precedes Sunrise and dusk comes after Sunset. Historical 
meteorological data can be referenced from a number of websites such as the US Naval Observatory 
Astronomical Applications. To enter the times:

	 Enter the desired time in the 24 hour format “##:##”

Note that sunrise and sunset in the Game are rounded to the nearest hour.

Min/Max Temperature

The minimum and maximum temperature fields are in degrees Celsius and dictate how hot or cold the 
air temperature is. They are used to determine the temperature for each hour of the day. This is more 
for user presentation and has no direct impact on game play. To set:

	  Enter the desired values in the MinTemp and MaxTemp fields.

Table 5 – Ground Condition Movement Effects

Move Type Normal Mud Quagmire Snow Ice
Bicycle 100 60 50 60 80
Foot 100 60 50 70 80
Half-tracked 100 60 50 60 80
Horse 100 65 55 65 82.5
Tracked 100 70 60 70 85
Wheeled 100 60 50 60 80

http://aa.usno.navy.mil/data/docs/RS_OneYear.html
http://aa.usno.navy.mil/data/docs/RS_OneYear.html
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Non-Historical Weather

There are three non-historical weather types – seasonal, better or worse. Seasonal weather should be 
based on what the average weather is for that particular part of the world at that time of year. This may 
vary from the historical. Better should be well “better” than Seasonal and Worse should be not as good 
as Seasonal.

Unlike historical weather where the pattern for everyday is set, the pattern for non-historical weather is 
randomly chosen based on the probabilities set in the list at the right of the window. The way this works 
is that it starts with a “previous” weather pattern. At the start of the scenario, the “previous” weather 
pattern is the same as the historical pattern for the first day.

It then determines whether or not it will remain stable ( ie no change ) using the Stable Probability 
value. Eg if this was set at “0.40” there would be a 40% chance it would remain the same. If it doesn’t 
remain stable, it then determines if it will rain, late rain, fog or snow ( in that order ) using their 
corresponding probability values.

From Day 2 of a scenario onwards the Stable Probability value is further reduced by 5% per day, thus 
making it more and more likely to change as time progresses.

To set the non-historical weather probabilities:

	 Select the weather type from the drop down list ( start with 
Seasonal )

	 Enter the desired values in each of the probability fields.

	 Repeat for the remaining weather types

As a general rule, set the Stable Probability higher for Better weather 
and lower for Worse weather. If you do not want any chance of getting a 
particular pattern then set it’s probability value to zero.

	Non-historical weather uses the same ground condition, sunrise, sunset, min temp and max temp 
values as the historical settings.



SCENMAKER MANUAL

66
© 2010-2017 Panther Games. All rights reserved. Command Ops is a trademark of Panther Games. All other trademarks and trade names 
are the properties of their respective owners and Panther Games makes no claim thereto.

Set Air Availability
Air Availability determines the number of airstrikes the side receives during each day. Airstrikes will 
only occur during daylight hours and the timing of each strike is random. To set the number of airstrikes 
for each day:

	 Right-click the desired Side Icon in the Force List and select Air 
Availability from the pop-up menu, or

	 Select Air Availability from the Side menu

	  Enter the desired number in the flights column next to each day

	 Hit OK

You can then set the number of airstrikes for each day of the 
scenario. Normally you will want to limit the number to five or less, 
unless one side should have overwhelming air superiority and close 
coordination with ground attack aircraft. Bear in mind that these 
strikes will all be fitted into the daylight hours of each day. 

Also airstrikes may be aborted due to poor visibility. So it’s a good 
idea to check the historical weather you have set and on the days 
you know there is a rain or snow pattern reduce the number or don’t 
allocate any.
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Set SEPs
Supply Entry Points ( SEPs ) mark the locations at which new supplies arrive during the game. Each 
side should have at least one active SEP. This is not mandatory but if a side doesn’t have one it cannot 
receive any supplies from off map, regardless of what’s entered in the Supply Schedule.

To create an SEP:

	 Select the SEP tool 
from the Sidebar

	 Click on the desired 
map location

	If the location is impassable the unit icon will snap to the closest passable location

To move an SEP icon:

	 Drag it to the desired location

To view the SEP Data window: 

	 Double-click on the objective’s icon 

	You can have multiple SEP Data windows open at once.

Note that each SEP automatically gets named “SEP #”, where # is 
a series number.

Arrival Type

Supplies can arrive by ground ( ie delivered by truck ), air drop ( by parachute ) or air landing ( by 
aircraft ). Those arriving by ground are simply transit through the SEP and are delivered using off-map 
transport to the on-map Bases that draw on the SEP. Those arriving by air drop or air landing end up in 
a dump at the SEP’s location. It is then up to the drawing Bases to transport them.

To set the arrival type:

	 Select the desired type from the drop down list.

	Locate SEPs with an arrival type of ground  on a map edge 
with a road
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Road Type

This refers to the quality of off-map road that connects to the SEP’s location. This only applies to 
ground SEPs. Set it to NULL for air drop and air landing SEPs. The better the off-map road the quicker 
the supplies arrive,

To set the road type:

	 Select the desired type from the drop down list.

	Match the off-map road type to the type of road at the SEPs 
location

Move Type

This refers to the means of off map delivery, either foot or wheeled. It only applies to ground SEPs.

To set the move type:

	 Select the desired type from the drop down list.

	As a general rule set to Wheeled

Alternate SEPs

In scenarios where 
reinforcement options 
provide for different 
arrival locations you may 
like to consider placing 
alternate SEPs. Eg if 
in one reinforcement 
schedule they arrive in 
the north and another in 
the east, consider placing 
two SEPs, one north 
and the other east. Then 
in the Reinforcement 
window of the “northern” 
schedule activate the 
north SEP and deactivate 
the eastern one and vice versa for the eastern schedule. To deactivate SEPs see Activate/Deactivate 
SEPs.
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Set Supply Schedule
The amount of supplies arriving from off map and through which SEPs they arrive is set in the Supply 
Schedule. To open the Supply Schedule for the current side:

	 Select Supply 
Schedule from the 
Side menu or

	 Right click on the side 
icon in the Force List 
and select it from the 
context menu.

This window has three lists. 

Daily Priorities

The first list, Daily Priorities, determines the amount of supplies arriving each day and the time frame 
in which they can arrive. The amount is expressed in terms of a percentage of the sides expected 
requirements. The expected requirements are based on the at-start forces plus scheduled reinforcements 
and ignore any losses or exits. So you don’t have to do any calculations or specify a set amount in 
tonnes. This will be done for you by the AI.

To set the daily priorities:

	 Enter the desired value in the Priority % column next to each day

A value of 100 means the force will receive its normal supply allocation. A value of 25 and it will only 
receive a quarter of what it normally needs. A value of 150 will see it receive 50% more than its normal 
allotment.

	As a general rule, limit the value to 100 or less

Normally the supplies are delivered in two events per day – one in the morning and one in the evening. 
Where the opposing side has significant air superiority, it is often more prudent to only deliver at night 
thus avoiding air interdiction. 

To restrict delivery to only the evening resupply determination event:

	 Set the Restricted field to 1

The side will still receive its total daily amount, though its Bases may not have enough time or capacity 
to then forward deliver them to the units.
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SEP Daily Priorities

The second list is used to determine the allocation priority amongst the active SEPs on each day. There 
is a column for each SEP. 

To enter the SEP daily priority:

	 Enter the desired number into the field for each day

A value of 0 will mean the SEP gets nothing. Any other value will see the SEP get a proportion of the 
supplies arriving that day. The proportion is determined by dividing the number by the total for all 
SEPs for that day. Eg. If we have two SEPs, one with a value of 1 and the other with a value of 2, then 
one will receive 33% ( 1 / 3 ) and the other 67% ( 2 / 3 ).

Use this to apportion supplies in line with the location of forces. Eg, if two thirds of a sides forces enter 
from the north and one third from the east, then set the northern SEP to 2 and the eastern SEP to 1.

Active SEPs

The third list specified the default settings for which SEPs are active or not. This will be duplicated 
each time a Reinforcement schedule is created. You can then override it in the Reinforcement window 
– see Activate/Deactivate SEPs.

To activate an SEP:

	 Enter a “1” in the Active column

To de-activate an SEP:

	 Enter a “0” in the Active column

Set Unit Initial Stock Levels
By default units start with 100% of their estab supplies. However, you can change the initial stock 
levels for units to simulate those that may start isolated or that have stockpiled supplies. 

To set the initial ammo, fuel and/or basics stock levels for a unit:

	 Select the unit(s) either on the map or in the Units list on the sidebar and 

	 Select the Unit>Set Initial Ammo>##% +/- Var menu item ( where ##% can vary from 0 to 1000% 
+/- variation )
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Note that if you selected an entry 
from the sidebar list and it has 
subordinates, then you will be 
asked to apply the changes to its 
sub-units.

Set Initial Orders Delay
This comprises two paramters - a Modifier and a Period. The Modifier applies a percentage modifier 
to the standard orders delay. The default is 100 meaning 100% or no effect. Setting this value to 200 
would double the standard orders delay. Setting it to 50 would halve it. 

The Period is the duration in minutes that the initial orders delay setting will last for. The default is 0 
or none. Setting the Period to 120 would see mit lasting for the first two hours.

If a Modifier and Period are set, then the Modifer will gravitate to the default value of 100% over the 
set Period. 

Eg 1. If you set the Modifier to 200 and the period to 120, then at game start the standard orders delay 
would be doubled, at start + 30 it would equal 175%, at start + 60 = 150%, at start + 90 = 125% and 
by start + 120 = 100%. 

Eg 2. Modifer = 0, Period = 240: start = 0%, start + 60 = 25%, start + 120 = 50%, 
start + 180 = 75% and start + 240 = 100%.

To set the initial orders delay:

	 Select Initial Orders Delay from the Side menu or 
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	 Right click the side icon in the force list and select it from the 
context menu

This will open Initial Orders Delay window.

	 Set the desired Modifier and Period values and hit OK.

Set Intel
In the Game, intelligence ( intel ) reports are generated when your units spot enemy units. In real life 
both sides would normally know something about the enemy forces in their sector. One side might 
know a lot about the other side, while they may have little information. Intel reports vary in their 
accuracy/reliability and they age over time. Eventually they will be deemed “stale” and removed from 
display.

As the scenario designer you can create your own intel reports for both sides. These will appear at 
scenario start and age as appropriate.

To provide intel reports:

	 Select the units on map that you want to show to the other side at the start of the game

	 Select the desired intel level from the Enemy Intelligence Level drop-down list in 
the Sidebar

As a general rule stick to Minimum intel.

To see what the report will be like:

	 Select the Intel Display Mode button from the Sidebar
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	 Select it again to turn off intel reports

Note that in this example 
only a few units are 
reported. If you look 
carefully at the Allied 
reports you will see 
that their data varies 
significantly from the real 
allied units. In fact, all 
the values are varied by 
a plus or minus margin 
from the real values. The 
poorer the intel level, the 
greater the margin. The 
better the intel the more 
accurate the values and 
force type displayed. 
With intel level set to max 

most intel reports will have the same force type and combat values as their real force.

Create False Intel Reports

You can move a unit to one location, set the intel level to create an intel report, then move the unit to 
another location. The report will remain at the first location! Moreover, you can place a unit on the 
map, set its intel and then remove the unit from the map – even more cunning. For instance, if you 
want the Germans to think that there is a British armoured regiment at a particular location, when in 
fact there is an infantry force there:
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	 Drag the units of an armoured regiment onto the map at the desired location

	 Select them

	 Set the desired intel level

	 Click back on the map

	 Select them again, and

	 Remove them from the map, leaving only the misleading intel reports behind.

Remove Intel Reports

	 Select the unit or intel report

	 Select No Intel from the Enemy Intelligence Level popup.

Recommended

It is strongly recommended that you set up intel reports on front line units where opposing forces are in 
contact. Otherwise you might find the AI will charge off to its doom unawares or deploy into defensive 
formation facing in the wrong direction. It will look really stupid to boot! 

If you have long range objectives deep in the enemy’s rear plus others on the front line and you want 
the friendly side to attack the objectives in the front first, then it’s best to provide some minimal intel 
on enemy forces near all objectives.

As a general rule, to start with, select all forces and set their intel level to min. You can then move the 
forces if you like. The intel report will remain where they were.
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Annex A - Estab Naming Conventions
Table 6 – Estab Unit Naming Conventions

Service Formation Meaning

HR German Army unit not specific to any type of division
PZD German Army unit specific to panzer ( armoured ) divisions
PGD German Army unit specific to panzer grenadier ( mech ) divisions
VGD German Army unit specific to volks grenadier ( 44 inf ) divisions
ID German Army unit specific to infantry divisions
PZLEHR German Army unit specific to panzer lehr ( demo ) division
2PZD German Army unit specific to 2nd panzer  division
116PZD German Army unit specific to 116th panzer  division
12ID German Army unit specific to 12th infantry  division
18VGD German Army unit specific to 18th volks grenadier  division
FBB German Army unit specific to Fuhrer Begleit brigade
FGB German Army unit specific to Fuhrer Grenadier brigade
O-Tag German Army unit specific to first day of Bulge offensive
SEC German security units
RAD German labour units

SS Nazi Party military unit not specific to any type of division
150 Nazi Party military unit specific to the 150th panzer brigade

LW German Air Force unit not specific to any type of division
FJ German Air Force unit specific to parachute divisions

KM German Naval ground unit not specific to any type of division

US American Line units
USAB American Airborne units
FSAS French Special Air Service
PAB Polish Airborne units

NL Dutch Army units
BA Belgium Army units

BSAS Belgium Special Air Service units
BR British Line units

GDS British Guards units
BAB British Airborne units
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Annex B – Scenario Design Sequence
After you have created or cloned your scenario follow these steps:

1.	 Set the Scene

2.	 Set Forces

3.	 Set Reinforcements

4.	 Set Objectives

5.	 Set Victory Conditions

6.	 Set Crossings

7.	 Set Weather

8.	 Set Air Availability

9.	 Set SEPs

10.	Set Supply Schedule

11.	Set Orders Delay At Start

12.	Set Intel
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Annex C – Scenario Check List

Must Do’s

	 Must have specified a valid Map file

	 Must have specified a valid Estab file

	 Each side must have at least one unit start on map or arrive in the first minute as a 
reinforcement

	 Each side must have at least one objective current at all times throughout the scenario

	 All units must have valid estabs

	 All units must have at least one soldier – ensure % of Estab is set to 1 or greater

	 All objective and reinforcement timings must be within the scenario start and end times

Should Do’s

	 All units should have a designation

	 Provide a briefing for the scenario and for both sides

	 In the scenario briefing, state any special instructions like “best played first as Germans”

	 Set the Weather

	 Provide each side with at least one SEP

	 Set the Supply Schedule for both sides

	 Set Intel for both sides

If the scenario is invalid and you start it in the game, you will receive an error message.
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Annex D – ScenMaker Tables

Table 2 – Data Included in Export / Import

Data Included in Export / Import?
Name Yes
Designation Yes
Estab No
Personnel No
% of Estab Yes
Staff Cap No
Staff Qual % Yes
Cohesion Yes
Fatigue Yes
Morale Yes
Experience Yes
Fitness Yes
Training Yes
Aggro Yes
Stubbornness Yes
Deployment Status Yes
Unit History No
Equipment Types and Numbers No
Basics, Fuel, Ammo, and Bridges No
Cmdr Name No
Rank No
Leadership Yes
Aggression Yes
Determination Yes
Efficiency Yes
Judgement Yes
Biography No

Table 1 – Allowable Designation Symbols

Symbol Name Usual Use

- Dash not usually used
, Comma not usually used
/ Forward slash usually used between battalion and regiment
. Period usually used between company and battalion or company and regiment
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Table 3 – Reinforcement Arrival Types

Arrival Type Meaning and Effect

Ground

Units arriving by road or already in place:
No effect on cohesion
Minimal dispersion
No casualties

Para Drop

Units arriving by parachute:
Cohesion greatly reduced
Great dispersion
Casualties if not arriving on smooth terrain

Bad Para 
Drop

Units arriving by parachute using the German technique:
Cohesion very greatly reduced with reduced recovery rate
Reduced initial firepower ( first hour )
Great dispersion
Heavy casualties if not arriving on smooth terrain

Glider Drop

Units arriving in crash-landed gliders:
Cohesion greatly reduced
Great dispersion
Heavy casualties if not arriving on smooth terrain

Aircraft

Units landing in aircraft:
Cohesion reduced
Minimal dispersion
No casualties

No Show See No Shows
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Table 5 – Ground Condition Movement Effects

Move Type Normal Mud Quagmire Snow Ice
Bicycle 100 60 50 60 80
Foot 100 60 50 70 80
Half-tracked 100 60 50 60 80
Horse 100 65 55 65 82.5
Tracked 100 70 60 70 85
Wheeled 100 60 50 60 80

Table 4 – Objective Properties

Property Meaning

Title Short description

Type Sets the achievement conditions for the objective

Start AI will start allocating forces to the objective at this time

End Objective becomes inactive at this time
Completion points are awarded at this time

HHour
Objective becomes active at this time
Available occupation points start to decrease from this time
AI may use Fastest Speed between Start time and HHour time

Priority See AI Objectives

Radius Sets radius of objective perimeter

AI Should 
Rebuild Bridge

For Secure Crossing objectives only:
Means the objective can still be achieved if the bridge is blown and rebuilt
AI will only build bridges where this box is checked
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Annex E - Keyboard Shortcuts
Alt Activates Zoomer - left click to zoom in, right click to zoom out
Backspace Delete
Del Delete
Enter (Num Pad) Open Unit Data window.
Enter Opens Unit Data window
Ins New Subordinate/Supreme Force
Print Screen copy the current screen to the clipboard
Right Click and drag Activates Grabber tool – left click and drag to scroll map

Ctrl-1 to 6 Zoom Map, 1 = 64 meters per pixel, 6 = 2 meters per pixel.
G Show Map Grid
U Toggle display of Units
Ctrl + N New scenario
Ctrl + O Open sceanrio
Ctrl + S Save scenario

Unit Filters

1 All units
2 HQ units
3 Line ( combat ) units
4 Support units / Bases
5 Armour units
6 Mech Inf units
7 Soft units
8 Gun units / Gun units that can Bombard
9 Engineer units
0 Bridge units
- Units without orders	
= Units with orders
\ Units with recent log entries (< 1 hour old)

Unit Info Box Filters

F1 Task 
F2 Rout Status
F3 Strength
F4 Combat Power
F5 Deployment / Facing
F6 Morale / Cohesion / Fatigue
F7 Ammo / Arty Ammo / Basics / Fuel / Supply Line
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